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Dette heftet er en del av introduksjonskurset til dataanlegget (Linux-kurset)
ved institutt for informatikk, Universitetet i Bergen. Kurset er spesielt bereg-
net på studenter som skal ta INF100, men det passer også for andre som skal
bruke dataanlegget, eller som vil lære litt praktisk bruk av Linux. Det er
lagt inn øvelser en del steder i heftet, og det anbefales at disse gjøres, for å
være sikker på at en har forstått alt før en går videre. Det forutsettes ingen
forkunnskaper eller tidligere erfaringer med datamaskiner, men de som har
dette, vil synes at de første delene av kurset er enkle.
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1 Elementært om Linux

1.1 Raskt om dataanlegget

De maskinene som brukes av laveregradsstudenter, kjører operativsystemet
CentOS Linux. Hvis du har brukt Microsoft Windows, vil du �nne mye til
felles med CentOS. Maskinene er fordelt på 3 rom i underetasjen av undervis-
ningsanlegget (UA) (eller auditorie�øyen som det også kalles). Disse mask-
inene kan kun brukes av de som tar kurs ved Institutt for informatikk. Du kan
benytte maskinene når som helst, også når du ikke har øvingingstimer. Bare
vær oppmerksom på at studenter som har gruppeøvinger, eller som jobber
med oppgaver, har prioritet på maskinene. Dersom du på noe tidspunkt har
problemer med en maskin, så kan du snakke med en terminalvakt. Dette er
en erfaren student som kjenner anlegget godt nok til å kunne hjelpe med det
meste. Terminalvaktene sitter i det største terminalrommet, og har vanligvis
vakt fra kl 10 til 18, alle hverdager. Og husk, under ingen omstendigheter skal
en maskin skrues av, eller startes. Snakk alltid med en terminalvakt dersom
du får problemer. Du kan også sende en e-post til terminal@ii.uib.no.

1.2 Innlogging

Når du først setter deg foran en maskin ser du et innloggingsvindu. Her
skal du skrive inn ditt brukernavn og passord. Brukernavn og passord får
du ved å registrere deg hos den Sentrale Brukeradministrasjonen, SEBRA.
Har du ikke fått konto ennå kan du få en terminalvakt eller gjerne en
medstudent til å hjelpe deg. Du kan opprette din egen konto på nettsiden
http://sebra.uib.no. Før du gjør dette må du ha registrert deg som stu-
dent på studentweb og ha ditt studentnummer og din pinkode for hånden.
Merk at det kan ta opptil 2 timer fra du har registrert deg til du kan opprette
konto via SEBRA.

Hvis du har informasjonen du trenger kan du skrive inn brukernavnet
ditt (f.eks. abc123). Når det er gjort trykker du på Enter , og skriver inn
passordet ditt. Legg merke til at du ikke kan se passordet på skjermen, men
det bare dukker opp som stjerner (*). Dette er for at ingen skal kunne stå
bak ryggen din og lese passordet ditt. Det kan gjøre det noe vanskelig å se
om du har skrevet det rett, men du får det fort nok inn i �ngrene. Når du har
skrevet inn passordet trykker du på Enter igjen. Dersom du får meldingen
Incorrect username or password, så skrev du enten brukernavnet eller
passordet feil. Prøv på nytt, men husk at du må skrive inn passordet nøyaktig
slik det står, og ta hensyn til om bokstavene er store eller små. Når du har
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skrevet alt rett, så vil maskinen begynne å laste inn dine innstillinger. Det
kan ta litt tid, så det er bare å vente.

I forbindelse med kurset vil vi også ha noen midlertidige kontoer som
studenter som har problemer med å generere konto via SEBRA kan bruke.
Disse kontoene er kun ment til bruk på introduksjonskurset og det er din
oppgave å sørge for å få opprettet din personlige konto så raskt som mulig.

Husk at passordet ditt er privat og at du aldri - ikke under noen oms-
tendighet - skal dele det med andre. Passordet beskytter dine data og din
identitet. I kapittel 6 �nner du noen nyttige tips om passord.

1.3 Skrivebord

Når maskinen er ferdig å tenke, så vil du sitte og se på skrivebordet ditt
(også kalt en desktop). Skrivebordet vil til å begynne med være noen ikoner
oppe i venstre hjørne, et bakgrunnsbilde (som du kan endre hvis du vil) og
en menylinje nederst på skjermen. Det vil også være en musepeker (som ser
ut som en liten pil). Ved din høyre hånd har du en mus. Ta denne, og prøv å
bevege den. Merk hvordan musepekeren beveger seg i takt med musen. Her
er noen av de vanligste brukene til musen:

Flytte vil si å bevege musen.

Klikke vil si å trykke lett og slippe venstre musknapp.

Dobbelklikke er å trykke og slippe raskt venstre musknapp to ganger.

Høyreklikke trykke og slippe høyre musknapp.

Trekke vil si å holde venstre musknapp nede over noe, og så bevege det til
en annen plass, der musknappen slippes.

Scrolle betyr å bruke hjulet mellom knappene på musen til å bevege seg
opp eller ned på en side.

Dersom du er venstrehendt, så kan du bytte om innstillingene på musen, slik
at venstre knapp fungerer som høyre, og omvendt. Snakk med en terminal-
vakt for hjelp med dette.

1.4 Vinduer og menylinjen

Du kan nå prøve å åpne et vindu. Dobbelklikk på ikonet på skrivebordet som
heter abc123's Home (der abc123 byttes ut med ditt brukernavn). Dette vil
åpne et vindu med en �lbehandler. Prøv å bruke musen til å �ytte vinduet
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rundt på skjermen. Dette gjør du ved å trekke vinduet når du har musen
over tittellinjen. Tittellinjen er den blå linjen øverst på vinduet. I det øverste
høyre hjørnet av vinduet har du også tre små knapper, fra venstre til høyre
er de en strek, en boks, og et kryss. Disse er felles for de �este vinduer, og
gir deg tre veldig enkle, men nyttige kommandoer lett tilgjengelig. Streken
minimerer vinduet. Det vil si at det forsvinner fra skjermen, og legger seg
i den høyre delen av menylinjen. Du kan få det tilbake ved å trykke på
ikonet med samme navn i menylinjen. Boksen maksimerer vinduet. Det vil
si at det utvider seg til å dekke mesteparten av skjermen. Du kan få det
tilbake til den forrige størrelsen ved å trykke på den samme knappen (som
nå har endret utseende litt). Den siste knappen, krysset, vil stenge vinduet.
Du legger også kanskje merke til at i nederste venstre og høyre hjørne er
hjørnene blå. Dersom du holder musen over en av dem blir musepekeren om
til en linje med pil i begge ender. Dersom du nå holder venstre musknappen
inne, så kan du endre størrelsen på vinduet som du vil.

. Prøv deg frem med å �ytte, minimere, maksimere, endre størrelsen og
lukke vinduer.

Dersom du ikke har det oppe, så åpne abc123's Home igjen (der abc123
byttes ut med ditt brukernavn). Vi skal nå ta for oss menylinjen. Den har tre
sentrale deler. Den første er til venstre, og består av forskjellige snarveier til
vanlige programmer. Ikonet lengst til venstre åpner hovedmenyen. Trykk på
den, så får du opp en liste over forskjellige programmer som du har tilgang
til. Vi skal ikke gå gjennom disse her, men du kan enkelt �nne frem til de
som du vil bruke. I menydelen lengst til høyre er forskjellige programmer
(som vi kommer tilbake til).

. Bruk hovedmenyen til å �nne frem til en kalkulator, et program som
kan brukes til å tegne diagrammer og et spill som heter FreeCell.

Til høyre for ikonene, er det �re små ruter. Disse er �re skrivebord som
du har tilgjengelig. Som du ser er ruten i øverste venstre hjørne blå. Dette
er det skrivebordet som er aktivt for øyeblikket. Du kan endre skrivebord
enkelt ved å trykke på den tilsvarende ruten. Disse skrivebordene kan brukes
til å fordele programmene du kjører, slik at et skrivebord ikke blir for fullt.
Øverste venstre hjørne i et vindu (f.eks. til �lbehandleren) har en liten pil.
Trykk på den, så kommer det opp en meny. De 4 nederste punktene lar deg
velge hvilket skrivebord det vinduet skal være i.

. Flytt �lbehandleren til skrivebord 3, og så tilbake til 1. Prøv deg frem
med å skifte skrivebord, og å �ytte vinduer mellom dem. Sett alt tilbake
til skrivebord 1 før du går videre.
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Det neste området, og det største, har en liste over alle vinduer du har oppe
på det skrivebordet du bruker. Du ser allerede det ene vinduet under navnet
abc123 (der abc123 byttes ut med ditt brukernavn). Dersom du åpner �ere
vinduer vil de også dukke opp som ikoner i menylinjen. Ett av ikonene vil
alltid være trykket mer inn enn resten. Det er det vinduet som er aktivt
akkurat nå. Det vil si at det ligger øverst på skrivebordet, og er det som
kommer til å reagere dersom du skriver noe på tastaturet. Du kan gjøre
et annet vindu aktivt ved å trykke på det tilsvarende ikonet på menylinjen.
Dersom du trykker på et ikon til et vindu som allerede er aktivt, så minimerer
du det. Trykk igjen for å få det tilbake. Helt til høyre på menylinjen har du
en klokke og en kalender.

. Prøv å åpne et nytt vindu med �lbehandleren. Legg merke til hvordan
det nå er to ikoner med det navnet i menylinjen.

. Dobbelklikk på ikonet Trash på skrivebordet. Du har nå fått et nytt
vindu. Bruk ikonene på menylinjen til å skifte mellom hvilken av de
som er aktiv, og prøv å minimere og gjenopprette dem.

. Når du føler deg komfortabel med alt til nå, kan du stenge alle vin-
duene.

1.5 Terminalvinduet og terminalkommandoer

Et mye brukt program er terminalvinduet. De som er kjent med MS-DOS vil
kjenne det igjen med en gang. Gjennom terminalvinduet har en tilgang på
alle programmer og kommandoer som en vil trenge. Terminalvinduet åpnes
fra hovedmenyen, under System tools, og programmet med navn Termi-
nal. Du skal nå ha fått opp et vindu som er helt hvitt, og har følgende tekst
(mer eller mindre):

[abc123@maur abc123]

Etter dette står det en blinkende boks. Dette kalles en prompt, og når
du ser en slik betyr det at terminalvinduet er klart til å motta kommandoer.
Hver kommando avsluttes med Enter . Vi kommer tilbake til terminalvin-
duet i senere kapitler, men nå kan vi prøve noen enkle kommandoer. Skriv inn

date

og trykk Enter . Du får nå opp dato og klokkeslett. Prøv også kommandoene
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cal og who. Legg merke til hva som skjer. Merk også at du kan �nne tilbake
til kommandoer du har skrevet tidligere ved å bruke opp og ned knappene
på tastaturet. Dersom du skriver feil kan du bruke høyre- og venstrepilene til
å bevege deg langs teksten, og Backspace til å fjerne tekst. Prøv deg frem
med dette, og bli komfortabel med terminalvinduet. La terminalvinduet bli
værende oppe når du er ferdig.

1.6 Utlogging

Du må alltid huske å logge ut fra en maskin før du går fra den. Dette er både
for å la andre bruke maskinen, men også for å hindre at uvedkommende skal
få tilgang på dine �ler, e-post osv. Du kan logge ut ved å trykke på Log Out
nederst på hovedmenyen. Husk å avslutte alle programmer du kjører før du
logger ut. Dersom du bare går fra maskinen for å gå på toalettet eller kjøpe en
Cola, så kan du låse skjermen i stedet for å logge ut. Du �nner låseknappen
rett over logg ut-knappen på hovedmenyen. Nå er du fortsatt innlogget, og
alle programmene dine kjører fortsatt, men ingen kan benytte maskinen før
du låser den opp igjen. For å gjøre det trenger du bare skrive inn passordet
ditt. Låsing av maskinen skal kun benyttes dersom du skal være borte noen
minutter, ikke dersom du skal på forelesning, eller hjem for kvelden. Dersom
du �nner en maskin der brukeren ikke har logget ut eller låst maskinen, så
bør du melde fra til en terminalvakt, eller logge personen ut selv. Du må
under ingen omstendigheter benytte muligheten til å se på denne personen
sine �ler eller e-post! Og husk, maskinene skal aldri restartes eller slås av.

2 Internett

Du har sikkert både hørt om og ska�et deg erfaring med internett. Det kan
brukes til så mangt, men skal vi konsentrere oss om tema som er relevant for
studiet: elektronisk post og �verdensveven� eller World Wide Web.

2.1 Verdensveven og bruk av nettleser

World Wide Web er det som mange forbinder med begrepet internett. For
å 'surfe' på internett, som det kalles, så bruker vi en nettleser. Det �nnes
mange nettlesere installert på dataanlegget, men vi skal konsentrere oss om
Mozilla Firefox som er anbefalt brukt av nye studenter. Mozilla Firefox
kan startes på �ere måter, avhengig av skrivebordets instillinger. Ofte �nner
du Mozilla Firefox som et ikon nede til venstre på skjermen - det ser ut som
en jordklode med en rev snurret rundt. Ser du dette ikonet kan du klikke en
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gang på det for å starte Mozilla Firefox. Det kan hende du må vente litt før
den starter.

Ser du ikke dette jordklode-ikonet kan det hende du må starte Mozilla
Firefox fra et annet sted på meny-ikonet helt nede til venstre. Klikk en gang
på ikonet for å åpne menyen. Ta deg god tid og se gjennom de forskjellige
valgene som �nnes, og øv deg på å �ytte rundt i menyene. Finner du ikke
Mozilla Firefox her heller kan du åpne et kommandovindu og skrive inn
kommandoen ��refox� som da vil starte Mozilla Firefox direkte. Spør noen
om hjelp hvis du står fast!

Øverst i Mozilla Firefox-vinduet �nner du en rad med menyer (File, Edit,
View osv). De er ikke så viktige ennå. Under dem �nner du �re knapper:
Back, Forward, Reload og Stop. Til høyre for dem er det en tekstlinje.
Denne bruker du til å skrive inn adressen til internettsider du ønsker å se.

. Først kan du gå til instituttets hjemmeside. Dobbel klikk på tekstlinjen
(teksten som sto der ble nå merket), og skriv www.ii.uib.no, etterfulgt
av Enter . Du vil nå få opp Institutt for informatikk sin hjemmeside.

Den delen av internett vi nå be�nner oss i, kalles ofte for World Wide
Web. Dette er fordi de �este sider på internett er forbundet med andre sider
gjennom linker. Som du ser på instituttets side, så er det �ere ord der som
er blå, og som endrer farge dersom du tar musen over dem. Det vil si at det
er en link, og hvis du trykker på den vil du gå til den siden som linken peker
på.

. Velg en av linkene, og trykk på den. Legg merke til at siden og adressen
i tekstfeltet endrer seg. Dersom du vil tilbake til den forrige siden, kan
du bruke Back-knappen, og Forward til å gå frem igjen. Reload-
knappen brukes til å laste en side på nytt, og Stop brukes til å avbryte
lastingen av en side. Prøv alle disse �re knappene, og bli vant til bruken
av dem.

Før du avslutter Mozilla Firefox, bør du gå til Retningslinjer for bruk av
instituttets dataanlegg. Dette �nnes fra instituttets hjemmeside, under intern
informasjon, driftsrelatert. Du trenger ikke lese alt dette nå, men det er
forventet at man kjenner innholdet innen kort tid etter studiestart.

2.2 Andre interessante internettsider

Her er noen andre nyttige internettsider som kan være av interesse:
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Studentportalen: www.studentportalen.uib.no: Side med informasjon
til studenter ved Universitet i Bergen. Du �nner også hjemmesidene
til alle kursene her.

SEBRA sebra.uib.no: Den Sentrale Brukeradministrasjonen. Her kan du
opprette kontoen din, bytte passord eller få nytt passord om du har
glemt ditt gamle.

doc.uib.no doc.uib.no: Dokumentasjonsprosjektet. Her �nner du mye nyt-
tig informasjon om dataanleggene ved fakultetet. Disse sidene kan redi-
geres av alle som vil men jobbes mest med av terminvalvaktene og
ansatte ved Institutt for Informatikk.

Google: www.google.com En søkemotor som du kan bruke til å søke etter
internettsider med informasjon du leter etter.

Universitetsbiblioteket: www.ub.uib.no Her kan du søke etter bøker og
tidsskrifter som biblioteket har eller abonnerer på.

Du står fritt til å surfe på nettet som du vil, så lenge du holder deg innenfor
reglene for dataanlegget. Bare husk at maskinene er først og fremst til faglig
bruk, og dersom det er liten plass, må du gi fra deg maskinen din til en som
skal jobbe med fag.

2.3 E-post og Mozilla Thunderbird

En sentral bruk av data-anlegget er å sende og motta elektronisk post, eller
e-post. Også her er det mange programmer tilgjengelig, men vi skal konsen-
trere oss om det som kalles Mozilla Thunderbird. Den enkleste måten å
starte Mozilla Thunderbird på er ved å bruke hovedmenyen. Mozilla Thun-
derbird �nnes under Internet. Før du kan motta eller sende epost fra Mozilla
Thunderbird må du fortelle programmet hvor det kan �nne eposten din.

. Gå til internettsiden http://doc.uib.no/wiki/EpostOppsett. Start
Mozilla Thunderbird og sett instillingene slik det forklares på inter-
nettsiden.

Når du er ferdig med hele prosessen skal du sitte med Mozilla Thunder-
bird oppe foran deg. I tillegg til hva som pleier å være på vinduer, har du
en rekke med knapper (Write, Get Mail osv). Under der har du en tynn
grå linje, og under der igjen har du tre store områder. Øverst til høyre er en
liste over alle e-postene som ligger i mappen du nå står i, og under til høyre
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er innholdet til den e-posten du har merket. Til venstre for disse to har du
liste over dine e-post mapper. For tiden har du ikke noen e-post å lese, så
det blir første steg.

. Trykk på Write knappen. Du vil nå få opp et nytt vindu der du kan
skrive e-posten. Du har �re tekstområder: et som heter From, et som
heter To, neste er Subject og til slutt, den største er der hvor du
skriver meldingen.

� I tekstområdet To skriver du adressen til den som skal motta e-
posten. Her kan du skrive din adresse, som er uk001@ii.uib.no
(der uk001 er erstattet med ditt brukernavn).

� Subject-feltet brukes til å skrive inn hva meldingen handler om,
slik at mottakeren vet hva det gjelder uten å trenge å lese hele
meldingen. Skriv inn noe passende her.

� Til slutt kan du skrive en melding til deg selv. Velg selv hva du
vil skrive.

Når du har gjort dette, er det bare å trykke på Send-knappen.

. Nå må du �nne innboksen din i området til venstre. Trykk på e-
postadressen din, og deretter Read messages. Du skal nå være i
innboksen din, og er klar til å motta den e-posten du sendte. Mozilla
Thunderbird kommer til å sjekke etter ny e-post ved jevne mellomrom
(standard satt til 10 minutter), men siden vi vet at det ligger en e-post
og venter på oss, kan dette fremskyndes ved å trykke på Get Mail-
knappen rett ved siden av Write-knappen. Du vil nå motta e-posten
du sendte til deg selv for noen minutter siden.

. Du kan nå prøve å sende til en person som sitter i nærheten av deg, og
han/hun kan sende til deg.

Ved siden avWrite knappen �nner du ogsåReply,Reply All og Forward.
Reply vil la deg sende et svar til den som sendte deg e-posten. Reply All
sender svar til den som sendte e-posten, og alle som mottok den. Forward
lar deg videresende e-posten til en annen adresse.

. Prøv alle disse tre, og legg merke til at i hver av tilfellene får du mu-
lighet til å endre innholdet i e-posten dersom du skulle ønske det.

Du har også mulighet til å legge med �ler i e-post. Disse kalles vedlegg, eller
Attachments, og du �nner Attach knappen ved siden av Send knappen
når du skriver en e-post. Dette bringer opp en meny som lar deg velge en �l
å legge ved.
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3 Kataloger og �ler

Informasjon lagres i form av �ler. En �l er en samling data som ligger lagret
på maskinens harddisk eller på et eksternt lagringsmedium, f.eks. diskett,
CD-rom eller magnetbånd. Maskinene på universitetet dessuten knyttet sam-
men med et felles �lsystem som fungerer via nettverket. Dette betyr at �lene
du lagrer alltid vil være tilgjengelig fra alle maskiner som er med i det samme
systemet.

I dette kapittelet skal vi bruke terminalvinduet til å manipulere �ler og
kataloger. Før vi kan sette ordentlig i gang må vi opprette noen �ler vi kan øve
oss på. Start et terminalvindu på samme måten som i går. Et terminalvindu
vil alltid starte i din hjemmekatalog.

. Skriv
curl -s doc.uib.no/wiki/uploads/linuxkurs.tar.gz | tar xvfz
-

og avslutt med Enter . Dette skal opprette de øvings�lene du trenger.

3.1 Kort om kataloger

Etterhvert som en lager �ere og �ere �ler får en også behov for en måte
å organisere dem på. I stedet for å ha alle �lene som en lang liste i en
enkelt katalog lager man underkataloger for å beholde oversikten. Tenk deg
et arkivskap. I stedet for å ha alle papirene i en sku�, har man �ere sku�er,
som hver inneholder mange mapper, osv. På samme måten fungerer kata-
logstrukturen på en datamaskin. Alle brukerne har hver sin sku� (kalt en
hjemmekatalog), og inni denne sku�en kan du lage mapper (eller kataloger)
for å holde bedre orden på alle papirene (�lene) dine. Du kan også ha kata-
loger inni kataloger inni kataloger osv. Så nå som vi har det bildet i hodet,
la oss begynne:

3.2 Katalogkommandoer

Du kan bruke kommandoen

pwd

(print working directory) på ethvert tidspunkt for å se hvor du er. Hvis
du prøver den nå vil du få noe sånnt som dette: /Home/abc123 (der ditt
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brukernavn står istedet for abc123). Dette er din hjemmekatalog, og innen-
for den kan du lage og slette kataloger og �ler stort sett som du vil. For å se
hva som �nnes i den katalogen du står i kan du bruke kommandoen

ls

Denne vil liste opp �lene og katalogene.

. Prøv kommandoen. Du vil få en liste med �ere kataloger og �ler, blant
annet en katalog som heter Mail og �ere forskjellige �ler. Øvings�lene
vi skal bruke heter neo, scotty, Smiles og Words. Sjekk at du kan
�nne dem i listen før du fortsetter.

. Prøv igjen, men bruk kommandoen ls -a denne gangen.

Du vil nå få opp en lengre liste som har både �ler og kataloger. De nye
på denne listen vil ha et punktum først i navnet. Dette forteller at de er
system�ler og kataloger, og er skjult fra ls så lenge du ikke henger -a på.
Det er som oftest en god ide å la system�ler og kataloger være i fred, og
ikke slette eller endre noen av dem (og det inkluderer Mail katalogen). Som
du sikkert la merke til, så var noen av punktene som dukket opp på listen
blå, andre var svarte, og en eller to var grønne. Disse fargene har forskjellige
betydninger. Svart betyr en �l, blå betyr en katalog, og grønn betyr en �l
som kan kjøres.

Du kan nå prøve å lage din egen katalog. Dette gjør du med kommandoen

mkdir katalognavn .

. Lag en katalog som heter dag1. Bruk ls for å få bekreftet at den ble
lagd.

Dersom du har gjort en feil, og lagd en katalog som du ikke skulle, kan du
fjerne den med kommandoen

rmdir katalognavn .

Merk at katalogen må være tom for at dette skal virke.

. Bruk rmdir og fjern dag1, og lag deretter en ny katalog som heter dag2.

For å �ytte fra en katalog til en annen brukes kommandoen

cd katalognavn .
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. Bruk denne, og �ytt til katalogen dag2. Bekreft at du står på rett sted
med pwd.

. Her kan du lage en ny katalog som heter mindir. Gå til den med cd
mindir. Bekreft på nytt hvor du er.

. Dersom du bruker cd uten noe katalognavn etterpå, vil du gå rett
tilbake til hjemmekatalogen din. Prøv det, og gå så tilbake til mindir.

Du kan også erstatte katalognavnet med .. (to punktum). Dette vil alltid
ta deg opp ett nivå i �ltreet, eller med andre ord, til den katalogen som
inneholder den du nå står i.

. Bruk denne til å ta deg først til katalogen dag2, og så til hjemmekata-
logen. Bruk pwd for å bekrefte hvert steg.

Legg også merke til at i tittellinjen på terminalvinduet ditt står katalogen
du be�nner deg i, relativt til hjemmekatalogen. Gå til mindir og se hva
som står i tittellinjen. Du har kanskje lagt merke til at du ikke kan gå fra
hjemmekatalogen til mindir ved å bare skrive cd mindir. Dette er fordi det
�nnes ingen katalog som heter mindir i hjemmekatalogen. Så for å komme
dit, må du først gå inn i dag2 og så videre til mindir. Alternativt kan du
bruke det som kalles en relativ sti. Det vil si at du erstatter katalognavnet
med en sti til den katalogen du vil til. Når du står i hjemmekatalogen din er
den relative stien til mindir 'dag2/mindir'.

. Prøv dette, og se at det virker.

Merk at katalogen du står i alltid har navnet '.' (ett punktum). Dette vil bli
nyttig senere.

. Lag en til katalog i dag2 som heter nydir. Gå til mindir og bruk det
du nå har lært til å �ytte deg til nydir i ett steg. Når du har fått dette
til, kan du slette nydir.

3.3 Opsjoner og argumenter

Mange kommandoer tar inn opsjoner og argumenter. Når du skrev ls -a
så var a en opsjon, og når du skrev cd mindir så var mindir et argument.
Alle opsjoner begynner med et minustegn (-), og de kommer i de �este
tilfeller før argumentene. Eksempler på opsjoner for kommandoen ls er a,
som tar med skjulte �ler og kataloger, l som tar med detaljer om �lene
og F som setter skråstrek (/) foran katalogene. En kommando kan ta inn
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�ere opsjoner og argumenter på en gang. Dersom du skriver mkdir en to
så lager du to nye kataloger, en og to. En kommando kan også ta inn både
opsjoner og argumenter på en gang. Kommandoen mkdir kan f.eks. ta inn
opsjonen v (som skriver en melding for hver nye katalog) samtidig som du
lager kataloger.

3.4 Filkommandoer

For å kunne lese innholdet i en �l kan man bruke mange ulike programmer,
men den enkleste måten er kommandoen

less filnavn

Du kan bla deg opp og ned i �len med med opp og ned knappene på tas-
taturet. Du kan bruke Page Up og Page Down for å bla sider av gangen.
Avslutt med å trykke q. Du kan også søke etter ord med å trykke / og så
ordet du søker etter. Merk at du ikke kan bruke less til å gjøre endringer i
�len.

. Prøv å bevege deg opp og ned i �len Words, og bli vant til å bruke
less. Prøv også å søke etter et ord.

Det �nnes et utall av operasjoner en kan gjøre på en �l, men nest etter
å lese den, er nok kopiering, �ytting (og navnendring) og sletting de viktig-
ste. Før du leser videre, sørg for at du har et terminalvindu oppe. Sjekk en
gang til at du kan �nne de �re øvings�lene neo, scotty, Smiles og Words i
hjemmekatalogen din.

3.4.1 Flytting av �ler

For å �ytte eller endre navn på en �l bruker vi

mv fra til (mv er kort for 'move')

Når �len skal få nytt navn skrives

mv fil nyttnavn

Når �len skal �yttes til en annen katalog blir det

mv fil katalog
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Dersom du ønsker både å �ytte �len og å gi den nytt navn, skriver du

mv fil katalog/nyttnavn

. Les innholdet i �lene neo og scotty. Bruk så mv til å endre navn på
�len neo til NEO, og deretter �ytt den til katalogen dag2. Gjør det
samme med �len scotty (gi den navnet SCOTTY), men i en operasjon.
Bekreft at innholdet i �lene er uendret.

3.4.2 Kopiering av �ler

Kopiering av �ler er ganske likt �ytting, største forskjellen er at du får to
utgaver av �len, som kan, men behøver ikke, ha samme navn. Kommandoen
for å kopiere er

cp original kopi

Akkurat som med �ytting, kan du gi kopien et nytt navn, eller kopiere den
til en katalog, eller begge deler. For å kopiere �ere �ler på en gang lister du
opp alle �lene med mellomrom mellom, og ta med katalogen de skal til til
slutt.

. Prøv nå å kopiere �len NEO fra katalogen dag2 til katalogen mindir,
uten å gi den nytt navn. Gjør det samme med �len SCOTTY, men la den
få tilbake sitt gamle navn. Gjør dette i en operasjon.

. Gå til hjemmekatalogen din, og i en operasjon kopier scotty fra mindir
til hjemmekatalogen din, uten å gi den nytt navn. Husk at katalogen
du står i alltid heter '.' (punktum). Du må bruke en relativ sti for å
gjøre dette.

3.4.3 Sletting av �ler

For å slette en �l brukes kommandoen

rm filnavn

Akkurat som med kopiering kan du slette �ere �ler på en gang, du trenger
bare liste dem opp som argumenter. Men vær oppmerksom på at dette er
en kraftig kommando, og det �nnes ingen måte å få en �l tilbake når den
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er slettet. Dersom du ønsker det, så kan du bruke opsjonen i for å bekrefte
sletting av hver enkelt �l.

. Bruk rm for å slette �len scotty fra mindir, og slett NEO fra dag2.
Bruk opsjonen i på en av dem.

3.4.4 Grep-kommandoen

I mange tilfeller kan det være nyttig å søke gjennom en �l etter et ord eller
mønster. Kommandoen for dette heter

grep ord fil .

Også her kan du ha med �ere �ler å søke gjennom. Det er bare å liste dem
opp etter du har skrevet ordet du leter etter. Dersom du leter etter en set-
ning kan du skrive den mellom to approstrofer. F.eks. dersom du leter etter
setningen Hei på deg i �lene fil-en og fil-to hadde kommandoen sett
slik ut: grep 'Hei på deg' fil-en fil-to.

. Bruk grep til å �nne alle linjer der ordet 'vampire' forekommer i �len
Smiles.

3.4.5 Filtilgang

I mange tilfeller er det hensiktsmessig å begrense hvem som har lov til å lese
eller skrive til dine �ler. Dersom du står i hjemmekatalogen din, og skriver
ls -l så får du opp en liste over alle (ikke-skjulte) �ler og kataloger. Legg
merke til at først på hver linje står det 10 tegn. F.eks. dette:

-rw-r--r-- 1 abc123 sstud 40 Jan 15 14:31 scotty
drwxr-sr-- 1 abc123 sstud 4096 Jan 15 15:02 dag2

Det første tegnet (det første minustegnet i den første linjen i eksempelet)
brukes til å skille kataloger fra vanlige �ler. De ni neste forteller hvilken
tilgang brukeren (du), gruppen og andre har på �len. Tegnene gir følgende
rettigheter: r betyr lese (read), w betyr skrive (write) og x betyr kjøre eller
åpne (execute) (ikke heng deg opp i at av og til står det en s istedet for en
x). De tre første tegnene forteller hvilke rettigheter du som brukeren har,
de tre neste er gruppen din, og de tre siste er andre. Så i tilfellet med �len
scotty har du rett til å lese og skrive til �len, mens gruppen din og andre
kan bare lese. Ingen har lov til å kjøre �len. En må ha rettigheten x for å
kunne åpne en katalog.
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For å endre rettigheter på en �l bruker vi kommandoen

chmod hvem+hva filnavn

Hvem i dette tilfellet er enten u (brukeren, eller user), g (gruppen, eller
group), o (andre, eller others), a (alle, eller all) eller en kombinasjon av
disse. Hva er enten r, w, eller x (eller en kombinasjon). En bruker + for å
legge til rettigheter, - for å fjerne rettigheter eller = for å overskrive alle
andre rettigheter med de nye. F.eks. vil chmod a+x scotty gi alle rett til å
kjøre �len scotty, mens chmod g-r scotty vil fjerne gruppen sin rett til å
lese �len. Kommandoen chmod a=r scotty vil fjerne alle andre rettigheter,
og gi alle rett til å lese �len.

. Prøv deg frem med å sette ulike rettigheter på forskjellige �ler og kat-
aloger, bare husk å gi deg selv skrive- og leserettigheter tilbake før du
går videre.

3.5 Jokertegn

Du har allerede brukt kommandoen ls til å liste ut innholdet i en katalog.
Du kan også bruke den til å søke etter �ler eller kataloger med et spesielt
navn. Dette gjøres enkelt ved å skrive �l- eller katalognavnet som et argu-
ment til ls. Bruk dette til å søke etter �len scotty i hjemmekatalogen din.
I mange tilfeller vet man ikke hele navnet, eller man er interessert i alle �ler
eller kataloger hvis navn inneholder et ord. I disse tilfellene brukes jokertegn
(eller wildcards som de heter på engelsk). Det �nnes tre typer jokertegn vi
skal gå gjennom her.

Først er ?, som kan settes i stedet for et enkelt tegn i søkeordet. Dersom
du skriver ls sco?ty får du �len scotty, mens ls sco? ikke gir noe resul-
tat. Tegnet * kan brukes i stedet for et vilkårlig antall tegn, enten ingen, ett
eller �ere. Å bruke hakeparanteser ([]) i stedet for et tegn gir en serie mu-
ligheter for det tegnet. F.eks. å skrive ls sco[wty]ty forteller at det fjerde
tegnet kan enten være w,t eller y. Dersom du skriver [3-7b-f] betyr det at
det tegnet kan være et si�er mellom 3 og 7, eller en bokstav mellom b og f.

Før du går videre bør du lage en ny katalog (du kan selv bestemme hvor), og
lag �ler med følgende navn i den: fil, fil_a, fil_b, fil_cde, fil.b,
filabcdthujc og fil.abcdefghi (du kan bruke cp til dette). Stå i den nye
katalogen, og bruk ett eller �ere av jokertegnene til følgende oppgaver:
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. List ut alle �ler som begynner på fil_ og som har bare ett tegn til.

. List ut alle �ler som har nøyaktig fem tegn i navnet.

. List ut alle �ler som begynner på fil .

. List ut alle �ler som har c som siste bokstav i navnet .

. List ut alle �ler som begynner på f og slutter på cde.

. List ut alle �ler med b eller c i navnet.

. List �lene med punktum eller understrek (_) i navnet.

3.6 Utskrift

For å kunne skrive ut en �l brukes kommandoen

lpr filnavn

Dette vil sende utskriften til standardskriveren for dataanlegget, som du
�nner i et eget rom mellom det store datarommet og det nærmeste av de
små datarommene. Du kan velge å skrive ut til en annen skriver dersom du
vil, men det er anbefalt å holde deg til standardskriveren. Du kan liste ut
skriverkøen for skriveren med kommandoen

lpq

og du kan slette en av dine jobber fra køen med kommandoen

lprm utskriftnummer

Utskriftsnummeret �nner du med lpq. Det �nnes noen �ler som en ikke
uten videre kan skrives ut med lpr. Disse krever spesielle programmer både
for å lese og for å skrive dem ut. Det �nnes også programmer som lager �nere
utskrifter av tekst�ler. Et slikt program er enscript, som bla. er mye brukt
til å skrive ut programkode. Dette vil det bli gitt mer informasjon om i kurs
hvor det blir nødvendig å bruke.

. Bruk lpr for å skrive ut en av �lene neo eller scotty. Prøv lpq for å
se hvilken plass du har i utskriftskøen.
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4 Jobber, prosesser og omdirigering av data

4.1 Jobber

Når du starter et program i et terminalvindu, så får dette vinduet en jobb.
Når dette skjer går jobben oftest i forgrunnen. Dette betyr at jobben opptar
vinduet, som ikke kan brukes til noe annet før jobben er avsluttet.

. Start et terminalvindu og skriv kcalc (dette starter en kalkulator).

. Flytt vinduene slik at du ser begge samtidig. Forsøk å kjøre en kom-
mando (f.eks. ls) i terminalvinduet.

Legg merke til at du ikke får noe respons fra terminalvinduet. Dette er fordi
kalkulatoren kjører i forgrunnen.

. Steng kalkulatoren og legg merke til at terminalvinduet ditt nå utførte
kommandoen du skrev inn tidligere.

. Start kalkulatoren på nytt, og steng terminalvinduet. Hva skjedde med
kalkulatoren?

For å kunne fri et terminalvindu som kjører en jobb i forgrunnen brukes
enten kommandoen

Ctrl-z eller Ctrl-c

Den første vil 'pause' jobben, og terminalvinduet kan nå brukes til andre
ting. Jobben kan plukkes opp igjen med kommandoen

fg

mens Ctrl-c avslutter jobben i forgrunnen. Hvis du bruker den er det in-
gen vei tilbake. Jobben er borte, og alle dataene du ikke hadde lagret er
tapt. Bør brukes varsomt! Vi bruker den vanligvis bare når noe er galt, f.eks.
hvis vi kjører et program som vi selv har skrevet, og som vi på grunn av en
feil i programmet ikke klarer å stoppe på annen måte.

. Start et terminalvindu igjen, og start kalkulatoren. Bruk Ctrl-z når
terminalvinduet er aktivt.

. Forsøk å gjøre noen beregninger i kalkulatoren. Merk at du ikke får
noe respons.
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. Bruk fg for å vekke kalkulatoren til liv igjen. Legg merke til at kalku-
latoren nå kan brukes igjen, og det du forøkte å beregne er blitt utført.

. Steng kalkulatoren.

For å kunne kjøre en jobb i bakgrunnen kan du henge & (et 'og' tegn)
bak kommandoen for å starte programmet. Dersom du har et program som
allerede kjører i forgrunnen, kan du 'pause' det, og så bruke bg til å starte
det igjen i bakgrunnen.

. Start kalkulatoren med kcalc &.

. Legg merke til at terminalvinduet fortsatt kan brukes.

. Start programmet nedit, denne gangen i forgrunnen. Pause den, og
bruk bg til å starte den igjen i bakgrunnen.

. Bekreft i hvert steg at terminalvinduet oppfører seg som det skal.

Kommandoen jobs bringer opp en liste over alle jobbene som kjører i
terminalvinduet. Mens du har begge programmene fra forrige oppgave oppe,
kjør jobs og legg merke til listen som kommer opp. Plusstegnet som står
foran en av jobbene, forteller at den jobben er aktiv. Med kommandoene fg
og bg kan du �ytte den aktive jobben til forgrunnen eller bakgrunnen.

. Kjør fg og deretter Ctrl-z. Kjør jobs igjen. Legg merke til at den
jobben som er pauset er merket med 'suspended'.

. Kjør jobs og legg merke til at jobben som er pauset fortsatt er aktiv.

Tallet først i listen er jobb nummeret til en jobb. Dette kan brukes til å �ytte
en jobb som ikke er aktiv til forgrunnen eller bakgrunnen. Bruk fg %n (der
n er jobbnummeret) eller bg %n. Dette vil �ytte jobben til forgrunnen eller
bakgrunnen, henholdsvis.

. Prøv begge disse kommandoen til å �ytte ikke-aktive jobber til for-
grunnen, eller bakgrunnen. Du kan godt starte �ere jobber dersom du
vil det. Steng alle utenom kalkulatoren og nedit når du er ferdig.

4.2 Prosesser

Opp til nå har vi kun sett på jobber, men dette avsnittet tar for seg prosess-
er. Merk at de kommandoene vi så på i forrige avsnitt, virker bare på jobber
som er startet i samme vindu. Prosesser er alle programmer som kjører på
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maskinen, og inkluderer jobbene i alle terminalvinduene. Det er ofte nyttig
å kunne �nne og stoppe programmer som ikke er startet fra et terminalvindu.

ps

Dette vil liste ut de viktigste prosessene, men langt fra alle. For å få �ere
prosesser kan du bruke opsjonen a. For å få alle prosessene som du kjører på
maskinen bruker du kommandoen

ps -u abc123 (der abc123 er ditt brukernavn)

Når du logger på, starter maskinen �ere små og store programmer, og det er
disse du ser på denne listen.

. Prøv hver av disse tre kommandoene, og legge merke til hvordan �ere
og �ere prosesser kommer til for hver av kommandoene. Se hvor mange
du kjenner igjen i hver liste.

Det er �re søyler i listen. Den første er prosess nummeret (PID), den neste er
hvilken terminalvindu prosessen kjører i, så kommer hvor mye tid prosessen
har brukt prosessoren og til slutt hva programmet heter.

. Opsjonen l til kommandoen jobs viser prosessnummeret til hver av
jobbene. Prøv denne, og bekreft at nummeret er det samme som du
får med ps.

I mange tilfeller er det nødvendig å avbryte (drepe) en prosess. Dette
gjøres med kommandoen

kill PID

Du kan eventuelt erstatte PID med %n, der n er jobbnummeret.

. Drep kalkulatoren med å referere til PID.

. Drep nedit med å referere til jobbnummeret.

. Start Mozilla, og drep den med PID. Du må nok bruke noen opsjoner
til ps for å �nne PID.

Noen ganger er ikke kill nok til å drepe en prosess. Det kan hende at du
må bruke
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kill -KILL PID

istedet. Men prøv alltid med vanlig kill først. Det er som oftest lurt å
avslutte et program ved hjelp av programmets egne kommandoer eller tit-
tellinjen før en prøver noe annet. Kommandoen kill eller Ctrl-c bør kun
brukes dersom et program har hengt seg, eller kommer ut av kontroll. For
programmer du har skrevet selv, er det ofte lurt å sjekke om de har stengt
seg selv ned dersom du har mistanke om at noe ikke gikk som det skulle.
Prosesser kan henge igjen også etter du har logget av, og skape problemer
for andre brukere.

Det er fullt mulig for mer enn en bruker å bruke en maskin om gangen.
Det �nnes �ere kommandoer for å �nne ut om noen er logget inn på den
maskinen du sitter på, men de vanligste er

finger, who og w

Vær oppmerksom at det kan �nnes systembrukere som kjører prosesser i
forbindelse med operativsystemet. Disse kalles gjerne root eller daemon.
Kommandoen ps har to opsjoner som gjør det mulig å se alle prosesser på
maskinen: e lister alle prosessene, men ikke hvem som eier dem. Og ef lister
alle prosessene, og hvem som eier dem.

. Bruk finger, who og w til å �nne ut hvem som er pålogget den mask-
inen du sitter på.

. Kjør ps -e og ps -ef og legg merke til forskjellene mellom disse.

4.3 Omdirigering av inndata og utdata

De �este kommandoer gir utdata til det vi kaller stdout (standard output).
Dersom vi ikke sier noe annet så blir dette skrevet i terminalvinduet. Men
av og til er det best å få utdataene i en �l, slik at den kan bearbeides senere.
Til dette brukes tegnet '>'. Det brukes på følgende måte:

kommando > filnavn

Dersom �len allerede �nnes, vil den gamle gå tapt. Hvis du bruker >> ist-
edenfor >, vil utdataene hengt på slutten av den gamle �len. Feilmeldinger
blir vanligvis ikke skrevet til stdout. Dersom du vil omdirigere feilmeldinger,
bruker du >& istedet for >. Dersom du ikke er interessert i utdataene i det
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hele tatt kan du sende dem til /dev/null. Dette er et stort svart hull for
data som ikke er av interesse.

. Skriv cal 4 1891 > kalender og les hva som kom på �len.

. Skriv cal 1891 4 > kalender og se på �len. Bytt så ut > med >&, så
se på �len igjen.

. Gjenta kommandoen fra punkt 1, men send utdataene til /dev/null.

. Gjenta kommandoen fra punkt 1, og deretter skriv cal 4 1892 >>
kalender. Bekreft at det som tidligere lå på �len ikke ble overskrevet.

Akkurat som de �este kommandoer sender utdata til stdout, så tar de
�este kommandoer inndata fra stdin. Dette er som regel terminalen. Og
akkurat som å sende utdata til en �l, så kan man også hente inndata fra en
�l. Dette gjøres med <.

. Kommandoen mail kan brukes til å sende en kort melding til noen.
Skriv følgende:

mail abc123 < kalender

(der abc123 byttes ut med ditt brukernavn). Dette vil sende innhold-
et i kalender til deg selv pr e-post. Sjekk om du har fått meldin-
gen om kort tid. Det anbefalte programmet for e-post, Mozilla Mail,
blir ikke tatt opp på kurset før på siste forelesning. Du kan likevel
sjekke hva du har mottatt ved å benytte Mozillas nettleser og gå til
http://webmail.uib.no. Her må du logge deg på med ditt brukernavn
og passord for å få sjekket eposten.

Det er også mulig å sende utdata fra et program rett inn til et annet. Til
dette brukes en 'pipe' (engelsk for rør), som er '|' tegnet. F.eks. kan det være
nyttig å kunne lese lange utdata med less.

. Kjør ps -ef | less.

Du kan også bruke grep til å søke gjennom utdata etter et spesielt ord eller
navn. Eller sort til å sortere utdata.

. Kjør ps -ef | grep terminal

. Bruk ps og grep til å �nne ut om mozilla kjører på maskinen.

. Kjør ps -ef | sort

. Kjør ps -ef | sort | less
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5 Tekstredigering

5.1 Teksteditorer

Vi har opp til nå arbeidet med �ler i forskjellige sammenhenger, og vi skal nå
lage og endre �lene selv. For å gjøre dette brukes en teksteditor. Det �nnes
mange forskjellige teksteditorer, og de �este som har arbeidet innenfor data
lenge nok har sin favoritt. Her er enkelte av de vanligste ved Institutt for
informatikk:

vi (kort for visual editor) er et av de eldste og mest tradisjonsrike Unix-
programmer, og er en populær editor blant mange avanserte brukere.

vim er en videre utvikling av vi for Linux, og har noen ekstra funksjoner
som vi ikke har.

emacs er et større program enn vim, og er lettere å komme igang med. En
populær teksteditor på instituttet med mange avanserte funksjoner.

nedit er et enkelt program å komme i gang med, men med en del avanserte
funksjoner for �ere forskjellige bruk. Noen foretrekker nedit fremfor
emacs.

gedit er et enkelt program som tilsvarer notepad på Windows. Den �nnes
i hovedmenyen under Accessories og kalles Text Editor.

Vi skal bruke Emacs som teksteditor til å begynne med, men etter hvert som
du blir mer vant til å bruke dataanlegget anbefales det at du prøver noen
av de andre editorene, for å �nne den som du liker å arbeide med. I dag blir
det gitt en kort innføring, mens neste kapittel tar for seg noen av de mer
avanserte funksjonene. Mange teksteditorer er avhengige av tastatursnarveier
for alle kommandoer. Dette gjør dem ofte vanskelige å lære (siden man må
huske alle snarveiene), men vi kan utføre operasjoner raskt med bare noen
enkle tastetrykk. Emacs har også mye av dette, men de �este funksjoner og
kommandoer �nnes også i menyene, slik at vi kan trykke oss frem til dem
med musen. Notasjonen menynavn > funksjon betyr at du skal gå til
menyen menynavn og �nne funksjonen funksjon.

. Start med et terminalvindu og skriv

emacs minfil &

Emacs vil nå starte og står klar til at du kan begynne å skrive. Skriv en
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eller to linjer, og så lagre endringene du har gjort i File > Save (cur-
rent bu�er). Gå tilbake til terminalvinduet (uten å stenge emacs) og
bruk less til å bekrefte at det du nettopp skrev kom med i �len. Skriv
en ny linje, og steng emacs med File > Exit emacs. Du vil nå få opp
et spørsmål om du ønsker å lagre endringene i �len før du avslutter.
Velg selv hva du ønsker (merk at dersom du velger å ikke lagre, så vil
du få et nytt spørsmål om du ønsker å avslutte). Start emacs på nytt
med kommandoen emacs minfil &. Legg merke til at du �kk opp den
samme �len som du nettopp avsluttet. Dersom navnet du skriver etter
emacs allerede eksisterer, vil emacs åpne den �len. Dersom den ikke
eksisterer, så vil Emacs lage en ny �l med det navnet. Dersom du ikke
skriver et �lnavn når du starter Emacs, må du velge å lage en ny �l
med File > Open File, og så skriv inn navnet du vil ha på �len. Du
kan nå stenge Emacs igjen.

. Lag en ny �l med navn kommandoer og åpne den i emacs. Her kan du
skrive en liste over alle kommandoer du har lært idag, pluss hva de
gjør. Husk å lagre �len når du er ferdig med den.

5.2 Mer om Emacs

Emacs har en mengde egenskaper og muligheter. Som det ble nevnt i forrige
kapittel har Emacs mange tastatursnarveier, og de �este kommandoer og
funksjoner �nnes både i menyene og som slike snarveier. Vi skal i hovedsak
bruke menyene, men tastatursnarveiene vil også bli tatt med, siden noen
foretrekker å bruke dem.

5.2.1 Raskt om tastatursnarveier

Alle tastatursnarveier er en kombinasjon av en kontrolltast og en eller �ere
andre taster. Det �nnes tre kontrolltaster vi skal bruke, og vi viser til dem
med følgende skrivemåte:

C - Control tasten (eller Ctrl ) skal holdes nede.

M - Alt tasten holdes nede.

E - Escape-tasten (eller Esc ) trykkes og slippes.

Altså betyr C-f at f trykkes mens Ctrl -tasten holdes nede, mens E-w betyr
at vi først trykker (og slipper) Esc og deretter gjør det samme med w. Vær
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oppmerksom på at dersom en kommando har snarveien C-x C-f så kan du
enten holde nede Ctl og så trykke x og f etter hverandre, eller du kan holde
nede Ctrl , trykke x, slippe Ctrl , så trykke den ned igjen, og så trykke f.
Dette gir samme resultat.

5.2.2 Raskt om brukergrensesnittet

. Start Emacs og åpne �len Smiles.

Dette vil legge �len i et såkalt 'Bu�er'. I praksis vil det si at Emacs har
en kopi av �len som ligger i bu�eret, og alle endringer som gjøres i Emacs vil
ikke gå lenger enn bu�eret inntil du velger å lagre bu�eret til en �l. Dette vil
også si at dersom du avslutter Emacs før du har overført bu�eret til en �l, så
kan endringene dine være tapt. La oss nå se på Emacs-vinduet. Øverst har
du tittellinjen som du sikkert er blitt veldig vant til nå. Under den �nner du
de forskjellige menyene. Under menyene er det en rekke med knapper. Dette
er knapper for mange av de vanligste tingene vi har bruk for i Emacs (Ny
Fil, Lagre, Åpne, Angre osv.). Under der igjen er teksten som �nnes i det
aktive bu�eret. Til venstre er en boks man kan bruke til å �ytte opp og ned
i teksten. Under tekstvinduet er det en liten grå linje. Dette er statuslinjen,
og den inneholder, fra venstre til høyre, følgende informasjon:

• � (uendret) ** (endret) %% (Read Only, �len kan kun leses).

• Navnet på �len (eller bu�eret).

• Modusen (blir forklart senere).

• Linjenummeret som markøren står i.

• Hvilken del av bu�eret du ser på (topp, bunn, %).

Under statuslinjen er ekkolinjen (eller minibu�eret). Denne brukes til å
gi kommandoer og vise meldinger.

5.2.3 Grunnleggende redigering

Et sted i tekstfeltet er det en blinkende markør. Denne forteller hvor eventuelle
endringer du gjør vil komme. Gå til bunnen av teksten og lag en ny linje.
Skriv noen ord, og gå så til midten av linjen. Dersom du ønsker å fjerne noe
du har skrevet kan du enten bruke Backspace (som sletter mot venstre) eller

Delete som sletter høyre. Du kan også bruke C-k for å slette fra markøren til

26



slutten av linjen. Prøv disse, og se hvordan de virker. Du har også mulighet
til å �ytte deg i teksten. Dette gjøres på følgende måter:

• Trykk med musen på det stedet du vil �ytte markøren til.

• Piltastene lar deg �ytte deg opp/ned eller høyre/venstre i teksten.

• Bruke tastene Home og End til å gå til henholdsvis begynnelsen eller
slutten av en linje.

• Tastene Page Up og Page Down �ytter opp eller ned en side om
gangen.

Dersom du gjør noe feil, kan du enten bruke Edit > Undo (eller C- _)
for å omgjøre endringene dine, en om gangen, eller du kan bruke File >
Revert Bu�er til å laste �len på nytt (dette vil ta deg tilbake til siste gang
du endret �len). Dersom du ved et uhell kommer inn i en uønsket modus,
kan du bruke C-g til å komme ut av den. For å lagre endringene bruker du
enten File > Save (current bu�er) eller C-x C-s.

5.2.4 Merking, klipping og liming

Å merke en tekst er det samme som å fortelle Emacs at her er en bit av
teksten jeg har spesielle planer for. For å merke en tekst brukes musen: Hold
venstre musknapp nede, og trekk musen over et område av teksten. Slipp
musknappen når du har merket det du ville. Alternativt kan du merke et
enkelt ord med et dobbelklikk, eller en hel linje med et trippelklikk. Den
merkete teksten kan du enten klippe ut eller kopiere. For å klippe ut kan
du enten bruke Delete eller Edit > Cut (C-w). For å kopiere teksten
bruker du Edit > Copy (M-w). Prøv begge to og legg merke til forskjellen
mellom dem. En annen måte å klippe eller kopiere er å sette markøren et
sted i teksten og trykke C- Space. Dette vil sette et merke i teksten. Flytt
så markøren til der du vil at klippingen eller kopieringen skal slutte og trykk
C-y for å klippe eller E w for å kopiere (husk at Escape-knappen skal slippes
før du trykker inn w). Prøv begge disse. Jeg anbefaler at du ikke lagrer noen
av endringene du gjør i bu�eret. Det er greit å ha �len noelunde intakt til
kommende oppgaver.

Den klippete eller kopierte teksten kan nå limes inn et annet sted. Dette
gjøres ved å plassere markøren der du vil ha teksten, og bruk Edit > Paste
(C-y). Teksten vil nå dukke opp der du valgte. En annen måte å kopiere
tekst på er å merke den, og så trykke den midterste musknappen (hjulet)
der du vil ha teksten. Dette fungerer også mellom terminalvinduet og emacs.
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Før du går videre, hent �len slik den var inn i bu�eret. Bruk det du nå
har lært til følgende:

. Flytt de to øverste linjene i bu�eret nederst, og kopier de to neste under
der igjen.

. Ta den øverste fjerdedelen av �len og klipp ut, og plasser den i midten
av det som er igjen. Du velger selv hvordan du vil utføre utklippingen.

. Gjør det samme som ovenfor, men kopier i stedet for å klippe ut.

5.2.5 Søking og utbytting av tekst

I Emacs kan en søke etter ord, enten bare for å �nne ordet, eller for å bytte
det ut med noe annet. Merk at i ethvert søk vil alltid Emacs begynne fra der
markøren står, så �ytt den til toppen av teksten dersom du vil søke gjennom
hele.

For å søke etter bare ett ord kan du bruke Edit > Search > Search
(C-s), eller Edit > Search > Search Backwards (C-r) for å søke oppover
i teksten. Etter at du har valgt en av de to, vil du bli bedt om å skrive inn
søkeordet. Vær oppmerksom på at søket ikke skiller mellom store og små
bokstaver, så å lete etter hei vil gi samme resultat som HEI. Det er fullt
mulig at det �nnes mer enn en forekomst av ordet i teksten, så fortsett
søket med enten å bruke Edit > Search > Repeat Search (eller Repeat
Backwards) (eller du kan gjenta tastatursnarveien). Enter resulterer i at
Emacs forlater søkemodus (men husker hvor den var) og C-g avbryter søket.
Vær oppmerksom på at å bruke søkefunksjonen fra Edit menyen ikke er helt
det samme som tastatursnarveien, og de fungerer på litt ulike måter, men
resultatet blir det samme.

. Bruk søkefunksjonene til å lete etter et ord du vet �nnes i teksten. Søk
både fremlengs og baklengs.

. C-s Enter C-w ord ord ord Enter søker etter �ere ord uavhengig
av hvordan de er separert. Bruk dette til å søke etter tre etterfølgende
ord.

For å bytte ut tekst kan du bruke Edit > Search> Replace (M-%)
Du blir nå bedt om å skrive inn teksten du søker etter, og så hva den skal
byttes ut med. I utbyttingsmodus har du følgende valg:

• Space eller y for å bytte ut ordet.
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• n for å hoppe til neste tre�.

• � for å gå tilbake til forrige tre�.

• Enter eller q for å avslutte.

• , for å bytte ut teksten, men ikke gå videre.

• C-I for å tegne skjermen på nytt og tilby ny utbytting av det samme
ordet.

• ! for å bytte ut alle de neste tre�ene.

• E (en stor e, ikke Escape ) for å endre søkestrengen.

Merk at søket her delvis skiller mellom store og små bokstaver, på en måte
som er ment å være nyttig i vanlig tekst. Prøv gjerne ut dette på egen hånd!

5.2.6 Stavekontroll

Stavekontroll er en nyttig funksjon som du �nner under Tools > Spell
checking. Her kan du først velge språk, og så sjekke enten enkelt ord eller
hele bu�eret. Når Emacs holder på med stavekontrollen, får du opp en rekke
alternativer for hva et ord kan byttes ut med. Hvert av disse har en bokstav
foran seg, og du velger ett av dem ved å trykke på den bokstaven. Videre
har du følgende valg:

• R lar deg bytte ut alle forekomster av det ordet med et annet før sjekken
fortsetter.

• Space aksepterer ordet denne gangen.

• A aksepterer ordet for resten av teksten.

• I aksepterer ordet og oppdaterer din private ordliste.

• Q avslutter staverettingen.

Du kan også bruke ? når som helst under sjekkingen for å få opp en
beskrivelse av disse og andre valgmuligheter.
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5.2.7 Moduser i Emacs

Emacs kan være i �ere ulike moduser. I en modus vil Emacs tilpasse seg
tekstredigering for en spesiell type �ler. Dette gjør arbeid med den typen �ler
mye lettere. Dersom ikke noe annet blir sagt begynner Emacs i fundamental-
moduset, men Emacs vil endre modus dersom �len som lastes inn i bu�eret
har et etternavn som Emacs kjenner igjen (f.eks. alle java-�ler slutter på
.java, og Emacs vil kjenne dette igjen som en java-�l, og skifte modus
deretter). Her er noen eksempler på moduser som er tilgjengelige i Emacs:

Fundamental

Text

Tex (Tex (og Latex) er språk som ofte brukes for å skrive bl.a. matematiske
artikler og dette dokumentet.)

C (�ler som er skrevet i programmeringsspråket C)

Java (Java er et programmeringsspråk som blir undervist i i INF100 og en
del senere kurs.)

Fortran (enda et programmeringsspråk)

HTML (for web-sider)

I de �este tilfeller vil Emacs selv sette moduset, men dersom du ønsker
å endre modus selv, kan du bruke kommandoen E x mode-name . For å få
informasjon om det moduset som blir brukt �nnes kommandoen C-h m.

. Bruk C-h m og les informasjonen om fundamentalmoduset. Skift til
javamoduset og les informasjonen der.

5.2.8 Andre småting

Du kan bruke C-x for å sette inn en annen �l i bu�eret.
C-h brukes for å få Emacs til å gå i hjelpe modus. Skriv h etterpå for å

få en kort forklaring av hjelpekommandoer.
C-h F viser Emacs FAQ (Frequently Asked Questions).
Filen .emacs i hjemmekatalogen din inneholder alle Emacs sine innstill-

inger.
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6 Litt av hvert

6.1 Stier og slikt...

6.2 Oppstart�ler

6.3 Tips om passord

Som du sikkert la merke til, så er ikke passordet som du �kk tildelt det
letteste å huske. Det er mulig å endre passordet, og det er også anbefalt å
gjøre dette jevnlig. For å endre passordet til innloggingskontoen (og samtidig
også e-post) kan du gå til http://sebra.uib.no og logge deg inn via �Min
konto�.

Å velge et godt passord er ikke enkelt, men det bør være både lett å
huske og vanskelig å gjette. Så du bør unngå passord som ditt navn, navnet
på et familiemedlem eller lignende. Vanlige ord er heller ikke å anbefale. Den
enkleste måten å få et bra passord på er å velge noe som betyr noe for deg,
men virker intetsigende for andre. Her er noen huskeregler for passord:

• Passord må bestå av minst 8 tegn, sikre passord helst 12 eller �ere.
Datamaskiner i dag er så raske at hvis passordet ditt inneholder færre
tegn vil det kunne være nokså enkelt for en tenkt angriper å �nne det
ved å prøve alle mulige kombinasjoner av tall, tegn og bokstaver.

• Passord skal ikke bestå av bare store bokstaver eller bare små bok-
staver (og heller ikke bare tall). Velg helst en blanding av store og små
bokstaver, tall og tegn.

• Passord bør ikke være satt sammen av navn eller ord på noe språk, for
det klarer dagens passordknekkeprogrammer å �nne ut av.

• Norske bokstaver æ, ø, å bør ikke brukes, siden disse kan kodes forskjel-
lig hvis du logger deg inn fra en annen maskin.

Hvis du er en aktiv internett-bruker vil du allerede være klar over at �ere
og �ere tjenester på internett krever brukernavn og passord for innlogging.
Det kan derfor være smart å huske iallefall minst to forskjellige passord til
enhver tid. Det er ikke å anbefale å bruke det samme passordet overalt -
dette fordi du ikke alltid kan være sikker på at de som lagrer passordet ditt
er like strenge med det som deg selv!

Du bør investere litt tid i å lage deg ditt eget �passordsystem� - et eksem-
pel på et slikt system ville være å huske et �sikkert passord� og et �internett-
passord�. Det sikre passordet benytter du kun når du vet at systemet som tar
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hånd om det er til å stole på, mens internett-passordet benyttes i tilfeller hvor
du føler deg mer usikker. For å gjøre det litt lettere kan internett-passordet
f.eks være det samme overalt - men du legger til den første og siste bokstaven
av internett-tjenestens navn til passordet. Hvis passordet ditt er piLSn3kt
og du har en konto til en tjeneste på www.gentoo.org legger du for eksempel
til �G� først og �o� sist i passordet, så det blir GpiLSn3kto. Vitsen med dette
er om at ditt passord blir avslørt på et av stedene vil det ikke uten videre
være det samme som du har alle andre steder. Lag din egen metode!

Tilslutt - du bør ikke ha passordene ditt skrevet ned noe sted. Husk at
passord ser forskjell på store og små bokstaver, så bt564ju! er ikke det samme
som bT564jU!

6.4 Vanlige problemer, nyttige tips?

6.5 Hjelp til selvhjelp

Kommandoen man brukes til å få frem manualsidene til kommandoer (man
er kort for manual). Unix har fra gammelt av et rikt hjelpesystem, og dette
er videreført i Linux.

Manualen er delt inn i åtte kapitler. Som oftest trenger en bare kapittel
1, der �nner man informasjon om de vanligste kommandoene, f.eks. ls. Når
man blir henvist til et program som man kan bruke, så skrives ofte 'ls(1)'.
Dette vil si at man kan lese om kommandoen i kapittel 1 i manualen. Argu-
mentet til man er et nøkkelord som du leter etter. Det er ikke nødvendig å
skrive kapittelet med mindre kommandoen (eller nøkkelordet) du leter etter
�nnes i �ere av kapitlene. Kommandoen man bruker less til å vise innholdet,
så du kan bruke de samme kommandoene til å bevege deg gjennom teksten.

. I et terminalvindu, skriv man ls og bla raskt gjennom informasjonen.

. Skriv man man for å få opp manualsidene til man, og bla raskt gjennom.

Tips: Ikke send manualsidene til skriveren, men lær deg heller å �nne det du
leter etter så raskt som mulig.

Det er ikke uvanlig at et nøkkelord forekommer på �ere sider. Det kan
være sider i ulike kapitler, ulike sider i samme kapittel (ofte ulike versjoner
av samme program) eller �ere kopier av samme side. Når du ikke har med
noen opsjoner får du kun opp den første siden (som oftest er den mest in-
teressante). Dersom du tar med opsjonen a får du opp alle sidene som ble
funnet. Når du stenger en side (med q) så kommer den neste opp. Med op-
sjonen w får du bare opp �lnavnet til man-siden, uten å vise manualen. Dette

32



kan brukes sammen med a for å �nne ut hvor mange sider det er, uten at du
trenger å bla deg gjennom dem.

. Bruk det du nå har lært til å bla raskt gjennom alle man-sidene til
man, og bruk opsjonene a og w til å �nne ut hvor mange det er, og hvor
de ligger.

Kommandoen whatis gir en kort forklaring av en kommando, og kan være
nyttig når du ikke trenger hele manualsiden for den. De �este man-sider har
også et avsnitt SEE ALSO. Her listes opp lignende kommandoer.

. Bruk whatis til å �nne ut hva disse kommandoene gjør: stop, file,
head, diff. Bruk SEE ALSO avsnittene for å �nne forskjellen mel-
lom head og diff.

Kommandoen apropos kan brukes dersom du ikke husker navnet på en
kommando eller et program, men du husker hva det gjør.

. Bruk apropos til å �nne andre e-post programmer ved å skrive apropos
mail og andre tekstredigeringsprogrammer med apropos editor.

Til slutt er det lurt å huske at mange vinduer har egne hjelpemenyer,
og at du kan spørre terminalvaktene dersom du får problemer som du ikke
�nner ut av selv.

6.6 Repetisjon

Her kommer det noen repetisjonsoppgaver. Du kan gjøre dem alene, eller
gjerne to og to. Du skal forklare en del kommandoer. Dersom du er i tvil så
bruk man-sidene til å �nne ut av det. Ikke prøv å kjøre kommandoen før du
tror du vet hva den gjør, eller har gitt opp.

. Forklar følgende kommandoer:
ls -a ../ > ../dir
cp ../fil .

. Hvordan ser en kommando ut som:

� Lister ut de aktive jobbene i et terminalvindu?

� Avbryter en prosess (som har hengt seg opp)?
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. Hva er forskjellen mellom de to kommandoene:
who | sort
who > sort

. Hva gjør disse kommandoene?
cp fil1 fil2 fil3 fil4 dir1
mkdir dir1/under
chmod a+x ov2/fil3
chmod u-w fil[3-7] ov2/fil3
mv opp[1-4] ov1/.
cp *.tex ../../
cd /
rm *pp[5-9] *

. Hva gjør denne kommandoen?
ps -ef | grep terminal | sort | mail ingen@ingen.steder

. Hvilken kommando . . . :

� lister ut �lene som har strengen taq i �lnavnet?

� lister ut �lene som begynner med stor eller liten 'g' og har et si�er
mindre enn 9 som fjerde tegn i navnet?

� �ytter all �lene i en katalog til en annen?

. Tenk over følgende:

� Hva er forskjellen mellom en opsjon og et argument?

� Hva er forskjellen mellom en �l og en katalog?

� Hva er forskjellen mellom en jobb og en prosess?

� Har du sjekket e-posten din idag? Det er lurt å sjekke den minst
en gang om dagen.
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